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Make sure that the voltage in your area meets the voltage 
requirements printed on the WorldRadio’s rear panel (AC 
230-240 V, 50 Hz). If you do not intend to use the 
WorldRadio for an extended period, remove the power cord 
from the AC outlet. 

3. Never Touch This Unit with Wet Hands 
Never handle this unit or its power cord while your hands 
are wet or damp. If water or any other liquid gets inside this 
unit, have it checked by your local dealer. 

4. Installing This Unit 
� Install this unit in a well-ventilated location. 
� Do not expose this unit to direct sunlight or heat 

sources. 
� Install this unit horizontally. Never use it on its side or on 

a sloping surface, because it may cause a malfunction. 
 

1. Read these instructions. 
2. Keep these instructions. 
3. Heed all warnings 
4. Follow all instructions. 
5. Do not use this apparatus near water. 
6. Clean only with dry cloth. 
7. Do not install near any heat sources such as radiators, 

heat registers, stoves, or other apparatus (including 
amplifiers) that produce heat. 

8. Protect the power cord from being walked on. 
9. Only use attachments specified by the manufacturer. 
10. Unplug this apparatus during lightning storms or when 

unused for long periods of time. 
11. Refer all servicing to qualified service personnel. 

Servicing is required when the apparatus has been 
damaged in any way, such as power-supply cord or 
plug is damaged, liquid has been spilled or objects have 
fallen into the apparatus, the apparatus has been 
exposed to rain or moisture, does not operate normally, 
or has been dropped. 

12. Damage Requiring Service 
Unplug the apparatus from the wall outlet and refer  

1. Care  
Occasionally you should dust the WorldRadio all over 
with a soft cloth. For stubborn stains, use a soft cloth 
dampened with a weak solution of mild detergent and 
water. Dry the WorldRadio immediately afterwards with 
a clean cloth. Don’t use abrasive cloths, thinners, 
alcohol, or other chemical solvents, because they may 
damage the finish or remove the panel lettering. 

2. Power 
WARNING 
BEFORE PLUGGING IN THE UNIT FOR THE FIRST 
TIME, READ THE FOLLOWING SECTION 
CAREFULLY. 
AC outlet voltages vary from country to country.  

 

 

 

 

 

 

 

 

 

 

 

Safety Instructions  

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Precautions  

 

 
 
 
 
 
 

 

 

 

The exclamation point within an 
equilateral triangle is intended to 
alert the user to the presence of 
important operating and 
maintenance (servicing) instructions 
in the literature accompanying the 
appliance. 

Caution: To prevent the risk of electric 
shock, do not remove cover (or back). 
No user-serviceable parts inside. 
Refer servicing to qualified service 
personnel. 

The lightning flash with arrowhead 
symbol, within an equilateral 
triangle, is intended to alert the 
user to the presence of uninsulated 
“dangerous voltage” within the 
product’s enclosure that may be of 
sufficient magnitude to constitute a 
risk of electric shock to persons. 

WARNING:  
TO REDUCE THE RISK OF FIRE OR ELECTRIC SHOCK, DO NOT EXPOSE THIS APPARATUS TO RAIN OR 
MOISTURE. 

CAUTION: 
TO REDUCE THE RISK OF ELECTRIC SHOCK, DO NOT REMOVE COVER (OR BACK). NO 
USER-SERVICEABLE PARTS INSIDE. REFER SERVICING TO QUALIFIED SERVICE PERSONNEL. 

servicing to qualified service personnel under the following 
conditions: 
A. When the power-supply cord or plug is  

damaged. 
B. If liquid has been spilled, or objects have fallen  

into the apparatus. 
C. If the apparatus has been exposed to rain or  

water. 
D. If the apparatus has been dropped or damaged  

in any way. 
E. When the apparatus exhibits a distinct change  

in performance this indicates a need for service. 
13. Object and Liquid Entry 

Never push objects of any kind into the apparatus through 
openings as they may touch dangerous voltage points or 
short-out parts that could result in a fire or electric shock. The 
apparatus shall not be exposed to dripping or splashing and 
no objects filled with liquids, such as vases shall be placed 
on the apparatus.  

14. Batteries 
Always consider the environmental issues and follow local 
regulations when disposing of batteries. 
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Dispose of the packaging and this product in accordance with the latest provisions. 

 

Notes on Environmental Protection 
 

After the implementation of the European Directive 2002/96/EU in the national legal system, the following applies: 

Electrical and electronic devices must not be disposed of with domestic waste. Consumers are obliged by law to return 

electrical and electronic devices at the end of their service lives to the public collection points that are set up for this 

purpose or designated points of sale. However, such details are defined by the national law of the respective country. 

This symbol on the product, the instruction manual or the packaging indicates that the product is subject to these 

regulations. By recycling, reusing the materials, or other forms of utilizing old devices, you are making an important 

contribution in protecting our environment. 

 

Trademarks 
 

The names of products or other vendors and suppliers appearing in this document may be trademarks or service 

marks of their respective owners, which may be registered in some jurisdictions. 

 

Microsoft, Windows, and Windows Media are trademarks or registered trademark of Microsoft Corp. in the United 

States and/or other countries. 

vTuner is a trade mark of vTuner.com. 

 

All other trademarks used in this document are trademarks or registered trademarks of their respective owners. 

 
Copyright Notice 

 
MPEG Layer-3 audio decoding technology licensed from Fraunhofer IIS and Thomson multimedia. 

 

This product is protected by certain intellectual property rights of NEMS and BridgeCo. Use or distribution of such 

technology outside of this product is prohibited without a license from NEMS and BridgeCo or an authorized subsidiary. 

 

This product is protected by certain intellectual property rights of Microsoft Corporation. Use or distribution of such 

technology outside of this product is prohibited without a license from Microsoft or an authorized subsidiary. 

 

Content providers are using the digital rights management technology for Windows Media contained in this device 

(“WM-DRM”) to protect the integrity of their content ("Secure Content") so that their intellectual property, including 

copyright, in such content is not misappropriated. This device uses WM-DRM software to play Secure Content 

(“WM-DRM Software”). If the security of the WM-DRM Software in this device has been compromised, owners of 

Secure Content ("Secure Content Owners") may request that Microsoft revoke the WM-DRM Software’s right to 

acquire new licenses to copy, display and/or play Secure Content. Revocation does not alter the WM-DRM Software’s 

ability to play unprotected content. A list of revoked WM-DRM Software is sent to your device whenever you download 

a license for Secure Content from the Internet or from a PC. 
 

Microsoft may, in conjunction with such license, also download revocation lists onto your device on behalf of Secure 

Content Owners. 

 

The information provided herein is believed to be accurate; nonetheless, the content may change without prior notice. 

We assume no responsibility for inaccuracies, errors, or omissions. And we assume no responsibility for the use of this 
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information, and all use of such information shall be entirely at the user’s own risk. Specifications are subject to change 

without notice. 
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Welcome 

Thank you for purchasing WorldRadio product. Your WorldRadio is designed to provide you hours of music enjoyment 

as much as we enjoy creating it with simple, convenient access to thousands of Internet radio stations worldwide. No 

matter whether you are in Alaska and would like to listen to the Hawaiian music, or whether you want to listen to the 

classical music, hard rock, or smooth jazz; the WorldRadio brings you home the radio station of your choice. 

Your enjoyment is our pleasure. Thank you very much. …. 
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1 – WorldRadio at Your Fingertips 

From Opening the Package to Installation 

Now please make sure that the content of the package is complete. Your WorldRadio comes with the following: 

 WorldRadio main unit 

 Power supply with cable adapter (9VDC，2A) 

 Ethernet Network cable (2 m) 

 Remote control (requires two AAA batteries) 

 WorldRadio User Manual 

 WorldRadio Quick Installation Guide 
 

 
Your WorldRadio 

 

 

                         

Power supply with cable adapter         Remote Cont rol  

 

 

 

Before You Start 

Please ensure that the Internet Broadband Network access is available before using the WorldRadio. 
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2 – WorldRadio Installation Step by Step 

 

2.1 Overview of Your WorldRadio 

After taking your WorldRadio out of the box, please spend some time to familiarise yourself with its features. 

 

 

2.1.1 WorldRadio Front Panel 

                                  

 

 

2.1.2 WorldRadio Rear Panel 

8. Home Button 

1. Power Standby 

2. LCD Display 

3. Speaker 

4. IR Receiver 

5. Four Preset Buttons 

6. Volume 

7. Headphone 

9. Return to Previous 

10. Tune Knob 

Push:Enter 
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2.1.3 The Remote Control 

 

The table below describes the functions of all the keys on the remote control in all three operating modes: 

Key Select and Play Modes Configuration & Edit Modes 

 Standby on/off (press) 

 Information button to switch between Play and Select screens 

~  
Hotkeys for selecting stored 

favorites 1 - 9 

Enter numbers and text: 
e.g.: Repeated presses of the ‘2’ key 

will scroll through ‘2’,’a’, ‘b’, ‘c’ 

 

Store current station/track as a 
PRESET. 

Press, then press required 
number key 

Inactive 

 Increase Volume Toggle upper/lower case 

 PLAYLIST: Open Select Menu for Dynamic Favorites list 

 Decrease Volume Toggle Insert/Replace modes 

 
Scroll Up / Down (see Note 1) to highlight previous/next menu item. 

Press and hold for fast scroll 

 Return to previous, higher level menu 

 Go to Home Menu 

 Select highlighted menu item 

 Like current station/track (add to Dynamic Favorites list) 

 Dislike current station/track (remove from Dynamic Favorites list) 

 
Skip back through track, album or 

playlist Backspace (delete last character) 

 Play selected station/track, or Pause currently playing station/track 

 
Skip forward through track (press and hold), or skip tracks in album or 

playlist (press) 

 Stop Play 

 
Repeat track (press once) 

Repeat all tracks in album or playlist (press twice) 

 Open Internet Radio menu 

 Open Configuration Menu (see Note 2) 

 Shuffle-play current album/playlist 

 
 

WorldRadio Remote Control  

Note: Gray shading denotes key is inactive in Configuration Mode 

 
Note 1) These keys can be used to scroll through all characters in Edit mode, but the keypad is usually a quicker 

method. 
 
Note 2) If pressed while editing, a screen appears asking if you want to Discard Changes. ‘No’ returns to Edit mode, 

‘Yes’ performs the normal function of the button. 
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2.2 Turning on Your WorldRadio for the First Time 

Preparing the WorldRadio for operation: 

1. Place the WorldRadio at a flat surface. 

2. Remove the packaging materials. 

3. Place the WorldRadio at a location close to Ethernet LAN access. 

4. Insert the batteries provided into the Remote Control device. 

5. If you are accessing the Internet via wired Ethernet LAN, please proceed to 2.2.1 Connection via Wired 

Configuration (LAN) . 

6. If you are accessing the Internet via wireless LAN, please proceed to 2.2.2 Connection via Wireless 

Configuration (WLAN). 

 

 

2.2.1 Connection via Wired Configuration (LAN) 

1. You may access the Internet Broadband Network by plugging Ethernet Cable to the 

back of the WorldRadio. 

 

 

2. Connect the power cable to the WorldRadio and connect it to the power supply. 

 

 

 

3. Wait for the WorldRadio to power up (it will take about 20 sec. to turn on for the first 

time); and then the welcome message will be displayed. 

 

 

4. When the WorldRadio is turned on for the first time, the Language menu will be 

displayed. You may select the Language by rotating the TUNE knob clockwise or 

counterclockwise; and then press the TUNE knob to select your language preference. 

 

5. The WorldRadio will now start the Configuration Wizard. Press the TUNE knob to 

proceed. 

 

 

6. Press the TUNE knob again to enter the Wired Ethernet LAN setting. 

 

 

 

7. Press the TUNE knob to select the Automatic (DHCP) for Network IP address setting. 
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8. Select NO option for proxy server and then press the TUNE knob. 

 

 

 

9. Press the TUNE knob again to apply the Settings. 

 

 

 

10. Your WorldRadio is now configuring.  

 

 

 

11. The network setting is completed and ready to play music! 

 

 

 

 

2.2.2 Connection via Wireless Configuration (WLAN) 

1. You may access the Internet Broadband Network wirelessly if you have a wireless 

Access Point in your location and you are authorised to use it. 

 

 

 

2. Connect the power cable to the WorldRadio and connect it to the power supply. 

 

 

 

3. Wait for the WorldRadio to power up (it will take about 20 sec. to turn on for the first 

time); and then the welcome message will be displayed. 

 

4. When the WorldRadio is turned on for the first time, the Language menu will be 

displayed. You may select the Language by rotating the TUNE knob clockwise or 

counterclockwise; and then press the TUNE knob to select your language preference. 

 

5. The WorldRadio will now start the Configuration Wizard. Press the TUNE knob to 

proceed. 

 

 

6. Press the TUNE knob again to enter the Wireless Ethernet LAN setting. 
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7. Please select your Access Point name then press the TUNE knob to enable your 

selection. Note: If you cannot see your Access Point's name on the list, please select 

"Rescan the Network" to search for your authorised Access Point.  

(In this example, “My WiFi SSID” is your Access Point of choice)  

Hint:  If your wireless LAN is encrypted, then proceed with step #8; otherwise, proceed 

to step #9. 

8. Password setting. You will be prompted to enter a valid WEP code (with the Remote 

Control for the entry). 

Tip:  use  to switch upper/lower-case letters (with the Remote Control).  

9. Press the TUNE knob to select the Automatic (DHCP) for Network IP address setting. 

 

 

 

10. Select NO option for proxy server and then press the TUNE knob. 

 

 
 

11. Press the TUNE knob again to apply the Settings. 

 

 

 

12. Your WorldRadio is now configuring. 

 

 
  

13. The network setting is completed and ready to play music! 

 

 

 
 
Congratulations! Your WorldRadio is now set properl y. 
 
The welcome message will be displayed; you may select radio stations from the Home Menu by pressing the  
button on the front panel of the WorldRadio. Then select “Internet Radio” by pressing the TUNE knob to choose your 
desired station through different modes of Genres or Countries. (Note: rotate the TUNE knob clockwise or 
counterclockwise to select your preferred station in different Countries or Genres, and then press the TUNE knob to 
select and listen to the station of your choice.) 
 

You may store your preferred station by pressing and holding any of the “1”, “2”, “3”, or “4” PRESET key on the 
WorldRadio’s front panel for 2 sec. You may then recall the stored station by pressing the corresponding 
PRESET key. You may press the Standby button to enter the WorldRadio into the Standby mode before next 
activation time.
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3 – Using Your WorldRadio 

 

3.1 Listen to the World Radio Program by Using the Front Panel Control 

After you have configured your WorldRadio, you can enjoy listening to radio stations around the world. You can quickly 

access a radio station by category by using the buttons on the front panel of the WorldRadio. The table below 

describes the functions of all the keys on the front panel. 

Key Function 

 
Standby on/off (short press) 

 
Select highlighted menu item (TUNE Knob) 

 
Increase/ Decrease Volume (Volume Knob) 

~  
Hotkeys for selecting stored favorites 1-4 

 
Go to Home Menu 

 

 
Return to previous, higher level menu 

  Power Standby 

When you have finished using the WorldRadio, press the Standby button . The display will become blank and 

the device will remain in a standby state, consuming virtually no power, until you press  again. Upon 

pressing the  button again, the WorldRadio will be activated and will start to play from the last station that 

you listened to prior to entering the Standby Mode. 

 

  Volume Knob 

You can adjust the playback volume clockwise or counterclockwise to increase and decrease the volume. A 

horizontal bar display shows the volume level as you are changing it, and returns a few seconds later to the Play 

Screen.  

 

Example  
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  TUNE Knob 

You may select the highlighted/selected items from any menu by turning the TUNE knob clockwise or 

counterclockwise to select your preferred audio sources, menu items or stations. Then press the TUNE Knob to 

select the item or station you want. 

 

Example  

 

 

 

 

 

 

 

 

 

 

 

 ~  Four Preset Buttons 

Simply store your preferred station by pressing and holding any of the “1”, “2”, “3”, or “4” PRESET key for 2 sec. 

You may then recall the stored station by pressing the corresponding PRESET shortcut key.  

 
Example  

 

 

 

 

 

 

 

Press Press 

Press Press 

Press 

Press and hold Press 

Press and hold 
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  Home Menu 

You can quickly access a radio station category by Countries or Genres simply pressing the Home Menu button 

once on the front panel of the WorldRadio. In the Home Menu, the display shows a number of menu items which 

represent different audio sources. Select “Internet Radio” from the Home Menu, and then select a station you 

want to hear by browsing through the displayed categories. 

 
Example  

 

 

 

 

  Return to Previous 

If the ＜＜＜＜ icon appears on the left of the screen, this means you can use this Button to go back to the previous or 

higher level menu screen.  

 
Example  

 

 

 

 

 

 

 

 

 

 

 

 

Press 

Press Press 
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3.2 Using Remote Control to Access More Features 

 

3.2.1 Listen to the WorldRadio by Using the Remote Control 

You may also access a radio station category by using the keys on the remote control of the WorldRadio. Please refer 

to the table on page 7 which describes the functions of all the keys on the remote control. The frequently used keys and 

their functions are listed below for your quick review. 

Key Function 

 
Standby on/off (press) 

 
Go to Home Menu 

~  
Hotkeys for selecting stored favorites 1 - 9 

 

Store current station/track as a PRESET. 
Press, then press required number key 

 

Like current station/track (add to Dynamic 

Favorites list) 

 

Dislike current station/track (remove from 

Dynamic Favorites list) 

 

PLAYLIST: Open Select Menu for Dynamic 

Favorites list 

 
Increase Volume 

 
Decrease Volume 

 

Return to previous, higher level menu 

 

Select highlighted menu item 

 

Open Configuration Menu 
 

 
Information button 

  Power Standby 

When you have finished using the WorldRadio, press the Standby button . The display will become blank and 

the device will remain in a standby state, consuming virtually no power, until you press  again. If you need to 

restart the device, for example, if the wireless link is lost, press and hold the Standby button until the display 

Restart Device appears.  
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When using the Standby button on the Remote Control to re-active the WorldRadio will not take you back 

to the last station listened prior to entering the Standby Mode; this is unlike using the Standby button on 

the Front Panel of the WorldRadio. 

  Home Menu 

You can quickly access a radio station category by Countries or Genres simply pressing the Home Menu button 

once on the remote control of the WorldRadio. In the Home Menu, the display shows a number of menu items 

which represent different audio sources. Select “Internet Radio” from the Home Menu, and then select a station 

you want to hear by browsing through the displayed categories. 

  ~  Using Presets  

Saving a Station to a Preset Number  

Simply store your preferred station by pressing the PRESET button , followed the number key you want to 

use to store the station (e.g. ). The message ‘Preset stored at 1 ’ will appear briefly. To change a preset , 

simply preset a different station to the same key.  

Please do not use  for storing a preset. The  is reserved for the Front Panel Standby button to 

store the last station that you listened to. Also, Presets ~  on the Remote Control are sharing with 

presets ~  on the Front Panel of the WorldRadio. 

Playing a Preset Item  

At any time, simply press the relevant number button and the preset station will play.  

 

Example of Diagrams for Using Presets  

To Store: 

 

 

 

To Play: 
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    Using Favorites 

Saving a Station to the Favorite Playlist 

To save a station in the Favorite Playlist , first start the station, then press the button . A message ‘Favorite 

added ’ appears briefly on the screen, or ‘Item already exists ’, if you try to save the same station twice.  

If you try to store more than 20 items in the Favorite Playlist , a ‘List Full ’ message appears on the screen, 

and you must then remove at least one item before adding any more. 

Selecting and Playing Favorites from the Favorite P laylist 

At any time, simply press the Playlist button  to display the playlist of up to 20 items. Then Scroll up/down to 

highlight the station you want to hear, and press the  button to play it.  

Replacing Favorites on the Favorite Playlist 

To remove a station from the playlist, first start it playing, then press the button . A message “Favorite 

removed” will appear briefly on the screen. You can then play a new station and store it by pressing . 

Example of Diagrams for Using Favorites  

To Store: 

 

 

 

To Check my Favorite Folder and to Play: 

  

 

 

 

 

 

To Delete: 
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Example 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

   Volume + -  

You can adjust the playback volume with the increase  and decrease  keys. A horizontal bar display 

shows the volume level as you are changing it, and returns a few seconds later to the Play Screen. 

  Return to previous or higher level menu  

If the ＜＜＜＜ icon appears on the left of the screen, this means you can use this Button to go back to the previous or 

higher level menu screen.  

  Select highlighted menu item  

To select from any menu, press the  key to highlight the item you want. The ＞＞＞＞ icon at the bottom 

right of the screen means you can now press  to select the item. 

  Open Configuration Menu 

Whenever you press the Configuration Menu key , the WorldRadio enters the  

Configuration Mode. The top level Configuration Menu looks like the table at the right.   

Scroll up/down to whatever you need and select it. 

  INFO button 

Press the INFO key  to return to the previous selected screen, where you can prepare your next track or 

station. The current track/station will continue to play until the end, or until you select something else (or change 

the active Profile). Press  at any time to return to the Play Screen. 
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Example 
 

 

 

 

 

 

 

Example of diagrams for listening to the Internet R adio Stations by using the remote control  
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3.2.2 Advanced Configuration 

There are two ways to change the setup of your WorldRadio. You can use the Remote Control and the Front Panel 

Control or you can use your WorldRadio WEB Interface accessed on any PC that can communicate with your 

WorldRadio. 

With just four exceptions, all configuration settings can be changed by either method. The exceptions are: 

1. Selecting a Language (Remote Control/Front Panel Control) 

2. Setting Date & Time information and formats (Remote Control/Front Panel Control) 

3. Changing Internet Radio list settings (Remote Control/Front Panel Control) 

4. Changing the name of a Profile (WorldRadio DMP-User Interface only) 

 

A. Configuration Management Using the Remote Contro l  

To enter Configuration Mode , press the (      ) on the remote control to display the Configuration Menu , which 

contains some or all of the following items , depending on settings: 

Select Language 

Scroll up/down to the Select Language item , and select it. Scroll up/down to highlight your language, then select it. All 

future screen messages will then be displayed in that language.  

The display language cannot be set by your WorldRadio DMP-User Interface. 

Advanced Settings 

This menu contains three items : 

� Profile Management 

If this item is followed by an asterisk in brackets, [*], Profile Management is enabled. If there is a blank space 

between the brackets, [ ] , it is disabled. 

To change, select the Profile Management menu, select Enabled or Disabled as required, then return to the 

Advanced Settings menu by pressing . 

 

� Key Management 

This operates in the same way as Profile Management , and must be enabled if more than one Encryption Key is 

needed. 

Key Management is always available when using your WorldRadio DMP-User Interface. 

� Edit Device Name 

The default name is World Radio . If Profile Management is enabled, you can enter your own names for any of the 

three available profiles, initially called Profile1, Profile 2 & Profile 3 . Select Edit Device Name , then select 

Change from the next menu. Edit the name, press , then return to the Advanced Settings menu (i.e. press ). 

The device name can also be changed using your WorldRadio DMP-User Interface. 
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Configure Date/Time 

The date and time formats can be set by selecting this menu. First the Select Time Zone menu offers a choice of 32 

standard zones, then Daylight Saving can be enabled or disabled and, finally, the Select Time Format menu offers 

5 display formats for the date and time, which are obtained automatically from the Internet. 

Select Profile 

If Profile Management is enabled, the Select Profile item will be seen. It can be used to change the active Profile . 

The active profile is identified by an asterisk ( [*] ). To change profile, simply highlight the new profile and select it. The 

WorldRadio will then display the message Restart Device while the new Profile is being activated. 

Device Status 

Select this useful item to scroll up/down through a list of all settings in the active Profile . This is pure 

information –nothing can be changed while scrolling through this item. 

Configuration Wizard 

The WorldRadio Configuration Wizard guides you through the process of configuring network profiles. It is used 

when you want to use the remote control to: 

� Install your WorldRadio for the first time 

� Make changes to your network profile settings or 

� Explore the more advanced options offered by your WorldRadio. 

a. Network Information Needed by the Configuration Wizard 

The Configuration Wizard guides you through the setup process, prompting you to select or edit all the settings for 

any of the available WorldRadio Profiles. 

1. Your WorldRadio determines some settings automatically during its search for available networks. 

Therefore it may not need to prompt you for all of settings during the process described below. 

2. You can leave the Configuration Wizard at any time by pressing      again. You will then be asked to 

confirm that you want to exit the Wizard and discard all changes. 
 

b. STARTING THE CONFIGURATION WIZARD 

The Configuration Wizard will start automatically the first time you power up your WorldRadio. 

To start the Configuration Wizard at a later time: 

1. Press       to display the Configuration menu. 

2. Scroll up/down until Configuration Wizard is highlighted, and select it. When the introductory message appears, 

press  to go to the next screen and begin the setup process. 

1. This process requires you to know some technical details of how your network is set up. If you are unsure 

of any of the settings, consult the person who set up your network, or refer to the appropriate network 

documentation. 

2. Please refer back to Edit Screens on page 7 for instructions on entering and changing text and numbers, 

using the Remote Control. 
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c. SELECTING A PROFILE 

If Profile Management is enabled, you will be prompted to Load Profile . Select one of the three Profiles for editing. 

Their default names are Profile 1, Profile 2 and Profile 3 , but they can be renamed, using your WorldRadio DMP-User 

Interface. If Profile Management is disabled, the Wizard will start at the next item . 

d. SELECTING A WIRELESS NETWORK 

At the Select Network menu, follow these steps to select the SSID for the wireless network profile you are editing: 

1. If more than one wireless network is available, scroll up/down and select the SSID you want to use. 

2. If the SSID is followed by ‘(encrypted) ’, you will be asked to accept ( ) or change the WEP or WPA encryption key. 

For security reasons, the current key will be shown as a row of asterisks, ***************. 

3. If you want to set up a network that is not currently active, select Edit Network SSID and enter a new SSID, which 

must contain between 2 and 32 alphanumeric, case-sensitive characters. 

4. Press  when you have finished setting the SSID. 

e. SELECTING A NETWORK TYPE 

If you have used Edit Network SSID , the Select Network Type menu will appear. Always select Infrastructure , as 

you should be using your WorldRadio with a wireless Access Point (AP) or a wireless router.  

f. SELECTING ENCRYPTION SETTINGS 

If you see the Select Encryption menu, select: 

� No if encryption is not used on the wireless network or 

� WEP or WPA, if encryption is used. 

 

If you select WEP or WPA, and Key Management is disabled, you will be prompted to Enter Key1 . 

If Key Management is enabled, you will see the Select Key Index menu and you must select one of the four possible 

keys for editing. If a key already exists in the current profile, a row of asterisks (*******) will be displayed in place of the 

key value. 

As you enter the key, the Key Type and Key Length will be displayed in the top of the screen, based on what you 

have entered: i.e. ASCII or Hex, 64 bit or 128 bit . Press OK, then select Exit Key Editing and select the required key 

if you see the Select Key menu. 

g. SELECTING NETWORK IP SETTINGS 

At the Network IP Settings menu, choose Automatic (DHCP) if your network uses DHCP or Static IP Address , if you 

want to assign a fixed IP address for your WorldRadio. 

If you choose Static IP Address , you will be prompted to edit/confirm the IP Address of the WorldRadio, the Subnet 

Mask, the Gateway, the DNS Server Preferred and (optionally) the DNS Server Alternate . 
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h. ENABLING A PROXY SERVER 

1. If you see the Enable Proxy Server menu select No or Yes, depending on whether or not your network uses a 

proxy server. 

2. If you choose Yes, you will be prompted to edit/confirm the Proxy Hostname (example: proxy.mycompany.com ) 

and then the Proxy Port (example: 8080). Press  after entering all Proxy settings. 

i. COMPLETING THE CONFIGURATION 

When all required settings have been entered, the Configuration Wizard will display the message: 

 

 

 

 

Press  to save your changes. If Profile Management is enabled, the Save to Profile menu will appear. Highlight 

the chosen profile and press  to finish. The message Applying Settings will be briefly displayed, followed by 

Restart Device , if the active Profile has just been altered. The WorldRadio will display the Configuration Menu if an 

inactive profile was changed, or the Home Menu if it has been restarted. 

 

If the message No Network Found or Network Error -> check config appears, the WorldRadio could not 

connect to any network: please refer to Troubleshooting on page 26. 
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B. Using WEB Interface  

Start your web browser on your computer and search for the IP address shown on WorldRadio’s LCD screen under 

Device Status / Software address (IP) ; as an example, if your IP is 192.168.1.15, then enter http://192.168.1.15 on 

your computer to start the WorldRadio DMP-User Interface. 

 

Check your WorldRadio Device IP from your WorldRadio following the procedure below. 

 

Example: 

                            

          

 

 

� Only when the Profile Management is enabled, you will be prompted to Edit Profile . Select one of the three 

Profiles for editing. Their default names are Profile 1, Profile 2 and Profile 3 , but they can be renamed, using your 

WorldRadio DMP-User Interface. The device name can also be changed using the WorldRadio DMP-User 

Interface. 

� Your WorldRadio DMP-User Interface cannot be used until your WorldRadio has been set up. 
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4 – For Network Expert User Only 
 

4.1 The vTuner Premium Service 

The WorldRadio comes with a license included premier version of the vTuner Internet Radio service. Select Internet 

Radio  from the Home Menu , then select a station by browsing through the displayed categories. 

The menu tree of Internet Radio  will include items like: My Favorites, My Added Stations, Genres, Countries,  New 

Stations, Most Popular Stations, ID# XXXXXXXXXXXXXX  and Help . 

You can customize this list by adding stations of your own via your web browser following the procedure below. 

1. Open the web browser and go to vTuner Premium Service at:  

http://www.radio369.com  

 

Note:  Please skip steps 2, 3, and 4 if your account has already been registered; you only need to Log on to 

the ”MEMBER LOGIN”  by proceeding to step 5. 

2. Enter your ID # of your WorldRadio in the ”Sign in with your ID # From the World Radio” area, at the lower left 

of the webpage, then click the  button. 

Please follow the following steps for retrieving yo ur WorldRadio's ID #: 

(For example, “001641C120ABLP”  is your WorldRadio’s ID number.) 
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 Example:  

 

 

 

 

 

 

 

 

3. Create a Login account. 

 

4. Enter your Email Address as well as a Password of at least 6 characters to register your account. 
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5. Next time while visiting vTuner Premium Service website, you only need to Log on to the ”MEMBER LOGIN”  at 

the top right on the webpage by entering your Email Address and the Password you already registered. 

 

Note:  After logging on successfully, you can start to use the two features of “My Favorite Groups”  and “My Added 

Stations”  described as follows. 

 

My Favorite Groups  

6. You can start to build up a set of My Favorites , sorted into user-defined Groups .  

� Choose your preferred stations browsed by Format, Location or Languag e. 

� Click the button to add the specific station to an existing or a new Favorites Group, which can be created by 

yourself. 

� Then click GO to apply it. 

7. To see your favorite playlist in your customized Favorite, click “Home” in the website and then your own Favorite 

Group folder to check them. 

8. You can update it manually from vTuner website at any time. 

 

My Added Stations  

9. For stations that are not currently on the vTuner Radio Station List, you may manually add stations you want by 

clicking  button in ”My Added Stations” . Now enter the information for the station you would like to add. You 

will see the page as shown below; you need to fill in the required fields. 

 

 

 

 

 

 

 

10. Click  button and your new added station will appear in the menu under ”My Added Stations” . 

11. To remove stations from your ”My Favorites”  or ” My Added Stations ” , click button to delete them. 

You may remove your vTuner Premium Service registration by selecting "Help" under Internet Radio menu 

tree and proceed with the RESET ACCOUNT process. Caution: this process will CLEAR all of your previous 

registered data including your password, My Favorite Groups, and My Added Stations. 
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4.2 Playing Music Stored in Your Computer 

The WorldRadio has UPnP (Universal Plug and Play) functionality that allows you to play music files stored in your 

computer supporting Windows Media Player 11 application. 

 

Microsoft offers the Windows Media Player 11 free of charge at present via the following link: 

http://www.microsoft.com/windows/windowsmedia/player/11/default.aspx 

 

Once the installation is complete, run it by starti ng “Windows Media Player” on your computer and follow  

these steps below:  

1. The display of first time opening the Windows Media 
Player. 

 

 

 

 

 

 

2. Select Tools � Options 

 

3. Select “Library” option and click “Configure Sharing” 
to share your music in your network.  

 

 

 

 

 

 

 

 

 

 

 

 

4. The display shows all media players found on your 
network. Select “Share my media to :” so that you 
may activate the selection. (the default is access 
denied) 
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5. You may choose “properties” by right clicking your 
mouse to see the ID(MAC) of the selected device. 

 

 

 

 

 

 

 

 

 

6. The window of "Device Properties” looks like this. It 
shows detailed information of the selected device. 

 

 

 

 

 

 

7. Finally select the computers and devices you would 
like to share from the list and click the “Allow” button, 
followed by the “OK” button to confirm that media 
sharing is active. 

 

 

 

 

 

 

 

8. Now you can see different audio sources from the 

Home Menu of your WorldRadio by pressing the 

 button. The music collection can be found 

via the artist, genre, album or the folder structure. 
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Appendices 

 

Appendix A: Specification 

 

Dimension      - 265 x 120 x 167 (mm) 

 
Display       - 128 x 64 dots Blue/White Graphic LCD Module 
 
Navigation      - Tune & Volume Rotary Knob 

- 4 Preset buttons 
- Home & Previous Selection Button 
- 32 keys IR Remote Control 

 
Audio Playback   - Compression format: MP3, WAV, Windows Media® Audio and  

WMA-DRM10 
- Internet radio station update from vTuner 
- UPnP™ support 

 
Acoustics       - Two 3 Watt / 4 Ohm Speakers 
 
Power Adapter      - Input: 100~240VAC, 50/60Hz 

- Output: 9VDC, 2A 
 
CE / FCC Declaration    - FCC Class B, CE  
 
Standards      - IEEE 802.11b/g (11/54 Mbit/s) 

- IEEE 802.3, IEEE 802.3u (10/100 Mbit/s) 
- UPnP™ 

 
Network Security     - WEP Encryption (64/128 bit key support) 

- WPA Encryption 
 
Connections      - Built in 802.11b/g Wi-Fi 

- Ethernet RJ-45 
- Power In 
- Headphone 3.5mm Jack 

 
Environmental requirements   - Operating Temperature:0~40 degree Celsius 
        - Storage Temperature:-20~60 degree Celsius 

- Operating Humidity:10~85% Non-Condensing 
- Storage Humidity:5~90% Non-Condensing 
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Appendix B: Troubleshooting 

 

FAQ -- Frequently Asked Questions and their answers 

► Nothing appears on the display when the WorldRadio  switched on.  
Ans:  

� If the power is unavailable, check that the WorldRadio power cable is properly connected and that the power 
is switched on. 

 
� If WorldRadio is not known to the network, check that the MAC address for the WorldRadio has been entered 

correctly in the wireless network's MAC Access Control. Turn off the WorldRadio and turn it on again by 
unplugging and then plugging the power mains. 

 
� If Internet is unavailable, check that the Internet access point / router has an active connection to the Internet 

or not. 
 
 
 
► Cannot find an Internet Radio station (message dis played: Connection Down).  
Ans:  

� If Internet connectivity is lost, check your internet access (e.g. by opening a browser and refreshing the page).  
 

� If WorldRadio is not known to the network, check that the MAC address for the WorldRadio has been entered 
correctly in the wireless network’s MAC Access Control. Turn off the WorldRadio and turn it on again by 
unplugging then plugging the power mains. 

 
� If Internet is unavailable, check that the Internet access point has an active connection to the Internet. 

 
� If the wireless network is incorrectly configured, open the WorldRadio PC Utility and select the WorldRadio 

that has the problem. Click the Profiles button and check that the active profile is correctly configured for your 
network. Turn on the WorldRadio and ensure that the correct profile has been selected. 

 
 
 
► Cannot connect to an Internet Radio station after pressing “Tune” and an error is displayed.  
Ans:  

� You are connected to a station that is running, but it is not currently broadcasting any music. Try again later or 
choose another station.  

 
� If the buffer is full (everything else seems normal), wait a few seconds until the buffer clears. If the problem 

persists, turn off the WorldRadio and turn it on again by unplugging and then plugging the power mains. 
 

� If the station is not up, try looking up the station’s Web site to see if there are any changes. Try a different 
Internet Radio station.  

 
� There is a VPN (Virtual Private Network) running on your Router. Disable the VPN while running the 

WorldRadio. Warning: this may adversely affect other programs and data - proceed with caution.  
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� Your Router and the WorldRadio are not on the same subnet. The Router and the WorldRadio must be on the 
same subnet. 

 
� The Router has a MAC filter enabled. Add the MAC address of the WorldRadio to the exception list.  

 
� Your Router does not have DHCP server enabled. Enable the Router's DHCP server function or use a 

different network profile that allows for a fixed IP address. 
  
  
 
► The WorldRadio does not react to the Remote Contro l nor to the Front Panel buttons and hangs in the U PnP 
Menu structure.  
Ans:  

This can be caused by network delays when sending out UPnP requests. Wait a few seconds and try again. If 
the problem persists, turn off the WorldRadio and turn it on again by unplugging then plugging the power mains  

  
  
  
► After accessing an Internet Radio station, the dev ice does not playback other Internet Radio stations .  
Ans:  

Turn off the WorldRadio and turn it on again by unplugging then plugging the power mains. 
  
  
  
► Cannot find my access point / wireless router.  
Ans:  

The WorldRadio is out of access point / wireless router's range. Try again by reducing the distance to the access 
point / wireless router.  

 
 
 
► The WorldRadio stops playing the music suddenly.  
Ans:  

You are connected to a station that is temporarily out of service. Try again later or choose another station.  
 
 
 
► Where can I find my WorldRadio settings?  
Ans:  

Select "Device Status" in the configuration menu. All configuration information and settings can be found here. 
  
  
  
► Can I change profile for using the WorldRadio in a  different location?  
Ans:  

Select the "Select Profile" in the configuration menu. You can create and store three personalized profiles in the 
WorldRadio that can be selected anytime you need them. 
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► Is it safe listening to the internet radio program  on my WorldRadio wirelessly?  
Ans:  

The WorldRadio if enabled with WEP encryption will be just as safe as other wireless accessing devices; and the 
WorldRadio will be less likely to be attacked by hackers. 

  
 ► Cannot hear any audio from the WorldRadio.  
Ans:  

Turn on the volume. 
  
 ► I am hearing a lot of static or interference on th e WorldRadio?  
Ans:  

The internet streaming rate may be too low on the station side. Try again later or choose another station.  
  
  
► Can I link the WorldRadio to my HiFi system?  
Ans:  

The WorldRadio has a standard 3.5mm jack at the front panel that can be connected to a hifi or a pair of 
headphones. 
Note: Please lower the radio volume before connecting it to the LINE IN on your hifi or Amplifier. And if no sound 
is heard, then slowly increase the volume. 

 
 
► The WorldRadio's display freezes, and there's no re sponse to press any of the buttons and/or knobs. 
Ans:  

� Press the Reset Button at the rear panel. Wait for 30 seconds or so for system to restart. 
 
� If failed, then turn off the WorldRadio and turn it on again by unplugging and then plugging the power mains. 

 
� If still doesn't work, be sure to check your network setting & connectivity. 

 
► Why am I seeing HTTP address like " HTTP://192.168 .0.4 " on screen ? 
Ans:  

� The WorldRadio is trying to establish LAN connection with your router to access to the internet; please wait for 
a few more seconds for the radio to restart. 

 
� If the WorldRadio wouldn't restart, please unplug then plug in the power mains to perform a physical restart. 

 
� And if the symptom persists, please also check your router setting. 

  
 ► The description for the two meter bars on Screen a re: 
Ans: 

Meter bar on the left side – the signal strength for wi-fi, a peaked bar indicates excellent strength, if don’t use 
wireless, it will show LAN icon. 

    
     Meter bar on the right side – buffer status, progress of the data stream buffering when connect to station, An 

emptying bar indicates a poor network connection, it means not enough data is being transferred to ensure 
continuous playback, it’s similar to the buffering when we retrieve the video files from Youtube. 

 
 
 

 

 

 

For further information, please refer to our websit e. 
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Appendix C: Regulations & Safety 

 

EU Declaration of Conformity 

 

This product carries the CE-Mark in accordance with the related European Directives.  

 

We hereby declare that the product is in compliance with EU Directive 89/336/EEC using EN55022:1998, 

EN55024:1998, EN61000-3-2:2000 and EN61000-3-3:1995. 

 

CE Warning: This is a class B product. In a domestic environment this product may cause radio interference in which 

case the user may be required to take adequate measures. 

 

Federal Communication Commission Interference State ment 

 
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of 

the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential 

installation. 

 

This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance 

with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that 

interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or 

television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to 

correct the interference by one of the following measures: 

� Reorient or relocate the receiving antenna. 

� Increase the separation between the equipment and receiver. 

� Connect the equipment into an outlet on a circuit different from that to which the receiver is connected. 

� Consult the dealer or an experienced radio/TV technician for help. 

 

FCC Caution:  To assure continued compliance, any changes or modifications not expressly approved by the party 

responsible for compliance could void the user's authority to operate this equipment. (Example - use only shielded 

interface cables when connecting to computer or peripheral devices). 

 

FCC Radiation Exposure Statement 

This equipment complies with FCC RF radiation exposure limits set forth for an uncontrolled environment. This 

equipment should be installed and operated with a minimum distance of 20 centimeters between the radiator and your 

body. 

 

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: 

(1) This device may not cause harmful interference, and (2) This device must accept any interference received, 

including interference that may cause undesired operation. 

 

The WorldRadio does not contain any user serviceable parts. Repairs should be made only by an authorized service 

center. Unauthorized repairs or modifications could result in permanent damage to the equipment, and void your 

warranty and your authority to operate the device under Part 15 regulations. 
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